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1. Подготовка к печати и размещению в Интернете 
Что такое технические требования и где их получить 
Технические требования — перечень требований, которым должно удовлетворять изображение, чтобы при 
заданной технологии репродуцирования его репродукция получилась качественной. 
Для общепринятых случаев воспроизведения можно сформулировать обобщенный список технических 
требований, однако, использование тех требований конкретной организации позволяет точнее учесть 
особенности технологии и получить более качественный результат. 
Точные тех требования запрашиваются в организации, которая будет заниматься репродуцированием (фото 
лаборатория, издательство, типография и т.п.) 
Основная задача технических требований — формализовать подготовку и проверку макетаов, тем самым 
сократив зависимость качества конечной репродукции от уровня некомпетентности участвующих в процессе 
сотрудников. 
Прежде чем следовать полученным техническим требованиям, внимательно проанализируйте их. К 
сожалению, встречается много глупостей и несуразностей, кочующих из одних требований в другие. 
Для самостоятельного изучения: 
Андрей Журавлев (перевод). «Руководство по подготовке цифровых изображений» 
1.1. Основные параметры технических требований 
Размер 
Разрешение 
Глубина цвета 
Цветовая модель 
Цветовой профиль 
Формат файла 

 
1.2. Размер и разрешение 
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Для устройств попиксельного вывода (экраны) размер изображения задается в пикселя, а указанное в файл 
разрешение никак на выводе изображения не сказывается. 
Не смотря на то, что разрешение картинки в этом случае может быть любым, лучше задавать ему единое 
привычное для себя значение. Это может пригодиться, например, при создании на картинке надписей. 
Для устройств гладкого вывода (печать) размер задается в милиметрах, а резрешение выставляется в 
соответствии с технологией печати. 
Если в тех требованиях к печати разрешение не задано, ставьте 300 ppi. Это округленное оптимальное 
разрешение, рассчитанное исходя из угловой разрешающей способности человеческого глаза и минимальной 
эффективной дистанции просмотра. 
1.3. Глубина цвета 
Для финального репродуцирования достаточной и даже избыточной является глубина 8 бит на канал. 
16 бит на канал необходимо иметь только как запас на обработку, чтобы избежать постеризацию. 
В 16-битном режиме передаются отсканированные или сконвертированные под последующую обработку 
изображения. 
Так же в 16-битном режыме передаются послойные файлы, если они изначально были сделаны в нем. 
Искусственный перевод из 8-битного режима в 16-битный не добавляет информации, поэтому смысла не 
имеет. 
1.4. Цветовая модель и профиль 
Lab обеспечивает однозначное аппаратно независимое представление цвета, поэтому часто используется для 
тестовых изображений, предназначенных для проверки качества настройки мониторов и печатных устройств. 
При передаче коммерческих изображений Lab можно использовать только в том случае, если Вы уверени в 
компетентности принимающего файлы человека, поскольку конечный вид репродукции будет зависеть от его 
действий. 
Модель CMYK используется только в том случае, когда весь допечатный процесс настроен таким образом, 
что количество конкретного красителя на печати однозначно соответствует количеству этого красителя, 
заданному в файле. 
На сегодняшний день таким образом построены только аналоговые печатные процессы (офсетная, глубокая 
печать), то есть цветоделить изображение (переводить в CMYK) нужно только при печати достаточно 
крупных тиражей в типографиях. 
Для вывода на экран и печати на цифровых печатных машинах (принтера, широкоформатная печать, 
фотопечать) применяется только модель RGB. 
Профиль репродуцирующего устройства (монитор, проектор, принтер и т.п.) запрашивается в организации, 
занимающейся репродуцированием. 
Если получить такой профиль не удалось, изображение подготавливается с профилем sRGB, или 
конвертируется к нему. 
Дополнительные материалы 
Андрей Журавлев « 012. FAQ по работе в Photoshop от Андрея Журавлева. Чем команда Assign Profile 
отличается от команды Convert to Profile?» 
Для самостоятельного изучения 
Тестовое изображение для проверки мониторов и принтеров 

 
1.5. Формат файла 
PSD применяется для передачи послойных макетов. 
TIF используется для передачи изображений в типографии (полиграфисты категорически не любят jpg) и 
передачи 16-битных исходников. 
Для размещения в интернете, отправки на печать в фотолабораторию, передачи заказчику готовых макетов 
можно использовать JPG. 
1.6. Требования для размещения в Интернете 
Размер — в соответствии с размером элемента страницы в пикселях. 
Разрешение — любое. 
Глубина цвета — 8 бит на канал. СКАЧАНО С WWW.SHAREWOOD.BIZ - ПРИСОЕДИНЯЙСЯ!
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Цветовая модель — RGB. 
Цветовой профиль — sRGB (внедрен). 
Формат файла — JPG (с фактором качества 8). 
Для самостоятельного изучения: 
Станислав Васильев. «Как вставить в пост фотографии для retina-экранов» 
Самостоятельная работа. 
02_Beach.tif 
Взять файл 02_Beach.tif 
Подготовить его для размещения в ЖЖ в формат 900х600 px 

 
1.7. Подготовка к печати в фотолаборатории 
Размер — в соответствии с выбраным форматом фотографии. 
Обратите внимание, точные размеры бумаги обычно отличаются от указанных в прайс-листах округленных 
значений. 
Для совмещения размеров изображения и размеров отпечатка применяются три варианта печати: «кадр 
целиком», «кадр в обрез» и «печать пиксель в пиксель» (см. сопроводительные материалы). 
Разрешение — 300 ppi в общем случае, или соответствующее оптическому разрешению печатной машины 
при печати пиксель в пиксель. 
Глубина цвета — 8 бит на канал. 
Цветовая модель — RGB. 
Цветовой профиль — sRGB в общем случае, или профиль конкретной печатной машины, если 
фотолаборатория его предоставляет. 
Формат файла — JPG с минимальной компрессией (максимальным фактором качества). 
Дополнительные материалы: 
Фотопроект. «Таблица стандартных форматов фотопечати» 
Фотопроект. «Кадр целиком / в обрез» 
Фотопроект. «Профили материалов печати» 
Для самостоятельного изучения: 
Фотолаборатория FOTO-ONE Lab / Графические профили (ICC)  
1.8. Экранная цветопроба 
Режим экранной цветопробы позволяет увидеть на экране, как будет выглядеть изображение после 
воспроизведения на заданном устройстве. 
Профиль устройства получается от подрядчика и устанавливается в операционной системе. 
Настройки экранной цветопробы производятся через команду View > Proof Setup > Custom (Просмотр > 
Варианты цветопробы > Заказной). 
В выпадающем списке Device to Simulate: (Имитир. устройство:) выбирается профиль печатного устройства. 
Ключ Preserve RGB Numbers (Сохранять числовые значения RGB) должен быть снят. В противном случае 
система управления цветом фактически будет отключена. 
В выпадающем меню Rendering Intent: (Метод рендеринга:) выбирается алгоритм пересчета внеохватных 
цветов. 
Опытные пользователи предпочитают Relative Colorimetric (Относительный колориметрический), как 
максимально точно сохраняющий все возможные цвета. 
Начинающим можно порекомендовать Perceptual (Перцепционный), поскольку он по возможности сохраняет 
полутоновые переходы на всех участках изображения. 
Ключ Black Point Compensation (Компенсация черной точки) во избежания неполноконтрастности 
репродукции в тенях должен быть включен. 
Ключи Simulate Paper Color (Имитировать цвет бумаги) и Simulate Black Ink (Имитировать черную краску) 
активировать не надо. 
Режим экранной цветопробы включается командой View > Proof Colors (Просмотр > Цветопроба). 
При наличии критических отклонений производится дополнительная коррекция, рассчитанная на 
воспроизведение данного изображения именно на этом устройстве. СКАЧАНО С WWW.SHAREWOOD.BIZ - ПРИСОЕДИНЯЙСЯ!
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Для самостоятельного изучения: 
Алексей Шадрин, Андрей Френкель. «Color Management System (CMS) в логике цветовых координатных 
систем» 

 
1.9. Подготовка к печати в типографии 
Размер — в соответствии с заданным в макете. 
При печати изображения как отдельного изделия (открытка) с каждой стороны должны быть дополнительные 
5 мм изображения, которые будут обрезаны (вылеты). 
Разрешение — 300 ppi (при размере отпечатка соответствующем размеру в макете), в конкретном случае 
можно попробовать определить разрешение более точно (в сторону уменьшения), но это не найдет 
понимания со стороны персонала типографии. 
Если исходное изображение при пересчете к требуемому размеру имеет разрешение более 200 ppi, его можно 
дотянуть до заданного размера при допустимом уровне качества. 
Глубина цвета — 8 бит на канал. 
Цветовая модель — CMYK 
«Перевод в CMYK до сих пор остается не только наукой, но и искусством…», так начинается раздел 
инструкции для американских фотографов, посвященный передаче изображений в типографию. К 
сожалению, это не далеко от истинны, и если вы не были тесно связаны с цветоделением (переводом в 
CMYK), лучше оставить этот процесс на откуп специалистам. 
Цветовой профиль — «универсальный» профиль в общем случае (как правило ISO Coated v2 300% (ECI) или 
Coated FOGRA39 (ISO 12647-2&2004)), или профиль конкретной печатной машины, если типография его 
предоставляет. 
Формат файла — TIF. Типографские пре-прессы очень консервативны и, скорее всего, просто не примут JPG, 
мотивируя это тем, что при такой передаче не могут нести ответственность за качество печати. 
Более подробно все вопросы подготовки к печати растровых изображений разбираются на курсе «Adobe 
Photoshop. Допечатная подготовка изображений» 
2. Повышение резкости 
2.1. Что такое резкость и почему ее приходится повышать 
«Резкость фотографического изображения — степень отчётливости границы между двумя участками 
фотоизображения, получившими разные экспозиции. (...) Субъективное впечатление о Р. ф. и. зависит от 
скорости, с которой меняется плотность в этой зоне, и абсолютной разности плотностей на её краях. (...)» М. 
Я. Шульман (БСЭ). 
Во-первых, резкость падает в процессе оцифровки изображения (первый этап). Из-за пятна нерезкости в 
плоскости пленки (матрицы), рассеяния света в толще эмульсии пленки, зернистости пленки и конечной 
апертуры сканера, антиалайзинг фильтра перед матрицей цифрового фотоаппарата, работы алгоритма 
демозаики при конвертации и т.п. 
В рамках современных технологий это падение резкости компенсируется ее повышением в raw-конвертере. 
Во-вторых, резкость реальной сцены повышается зрительным аппаратом человека (второй этап). В следствии 
повышенного восприятия контрастных контуров наш мозг делает сцену более детализированной и объемной. 
Таким образом, для более полного соответствия реальной сцене должна быть повышена резкость 
репродукции в соответствии с ее сюжетным содержанием. Именно это и считается классическим 
повышением резкости. 
В-третьих. резкость падает в процессе воспроизведения, в зависимости от технологии воспроизведения. 
Это требует финального повышения резкости после приведения размеров к финальным и в соответствии с 
технологией воспроизведения 
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2.2. Трехступенчатое повышение резкости 
Этап первый. Предварительное усиление резкости в соответствии с источником изображения (цифровая 
фотокамера, скан со слайда, скан с негатива). Основной задачей на этом этапе является борьба с имеющимися 
на картинке шумами, а легкий шарп используется для компенсации падения резкости от действий 
«шумодава». 
Этап второй. Основное усиление резкости в соответствии с сюжетным содержанием на полноразмерной 
картинке. Такое усиление резкости можно yазвать «классическим». В результате получается файл, 
называемый автором «мастер-изображением», и являющийся основным обработанным оригиналом, 
пригодным для архивного хранения и использования на последнем этапе усиления резкости. 
Этап третий. Финальное усиление резкости на картинке, приведенной к размеру и разрешению с которыми 
она будет воспроизводиться. Параметры усиления резкости определяются исходя из технологии процесса 
воспроизведения (в основном рассматриваются различные виды печати) и финальных размеров изображения. 
Для самостоятельного изучения: 
Брюс Фрейзер «Усиление резкости фотографий в Adobe Photoshop» 

 
2.3. Принцип нерезкого маскирования 
Искусственное повышение резкости строится на создании вдоль контрастных границ ореолов: светлого со 
стороны более светлой области и темного со стороны темной. 
Для повышения резкости используется нерезкая (размытая) версия изображения. 
Фактически, мы находим разницу между реальной и дополнительно размытой версией изображений и 
предполагаем, что разница между «идеальной» и реальной картинкой точно такая же. 
Добавив эту разницу к реальному изображению мы получаем картинку близкую к «идеальной». 
В аналоговом процессе размытая версия использовалась при одной из экспозиций в качестве маски, от этого 
метод и получил свое название: «нерезкое маскирование». 
Для самостоятельного изучения: 
Андрей Журавлев «Искусственное повышение резкости 1. Теория». 
Андрей Журавлев «Искусственное повышение резкости 2. Рассуждения». 

 
2.4. Фильтр Unsharp Mask 
Фильтр Filter > Sharpen > Unsharp Mask (Фильтр > Усиление резкости > Контурная резкость) — один из 
самых старых инструментов Photoshop, напрямую реализующий принцип нерезкого маскирования. 
Параметр Amount (Эффект) определяет силу воздействия (яркость ореолов). 
Подбирается последним исходя из необходимой степени повышения резкости. 
Параметр Radius (Радиус) определяет степень размытия нерезкой маски. СКАЧАНО С WWW.SHAREWOOD.BIZ - ПРИСОЕДИНЯЙСЯ!
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При классическом повышении резкости подбирается первым исходя из степени нерезкости исходного 
изображения. 
Параметр Threshold (Изогелия) определяет начиная с какого перепада яркостей будет повышаться резкость 
контрастного перехода. 
Подбирается после параметра Radius, исходя из необходимости исключить из повышения резкости шумы и 
тонкие фактуры. 
При работе Threshold (Изогелия) происходит подавление не только низкоконтрастных ореолов, поэтому 
применять его не желательно. 
Для самостоятельного изучения: 
Андрей Журавлев «Искусственное повышение резкости 3. Фильтр Unsharp Mask». 
Андрей Журавлев «Искусственное повышение резкости 4. Фильтр Smart Sharpen». 

 
2.5. Метод HiRaLoAm (High Radius Low Amount) 
Повышение резкости с большим значением радиуса и малым воздействием (High Radius Low Amount), строго 
говоря, уже не является повышением резкости. 
Это усиление не микроконтраста (контраста в малой окрестности контрастных границ), а увеличение 
контраста локального (между светлыми и темными областями изображения, имеющими размер меньше или 
близкий к значению параметра Radius). Фактически, придание дополнительного объема элементам 
определенного размера. 
Этот метод используется для увеличения ощущения объема малых и средних деталей изображения. 
Дополнительные материалы: 
Андрей Журавлев. «Искусственное повышение резкости 7. High Pass — практическое применение» 

 
2.6. Метод «High Pass — Overlay» 
Фильтр Filter > Other > High Pаss (Фильтр > Другое > Цветовой контраст) выделяет разницу между 
изображением исходным и размытым по гауссу с заданным радиусом (ореолы нерезкого маскирования). 
В режиме наложения Overlay (Перекрытие) эти ореолы вносятся в основном в средние тона исходного 
изображения, существенно ослабевая в светах и тенях. 
Таким образом мы получаем максимальный визуальный эффект при минимуме «грязи» в светах и тенях. 
Поскольку ореолы не внедрены в изображение, возникает возможность их дополнительной доработки и 
складывания нескольких карт ореолов с разными радиусами. 
Смешивая заготовку для карты ореолов с различными пропорциями каналов, можно добиться разной степени 
повышения резкости на разных участках изображения без применения масок. 
Для самостоятельного изучения: 
Андрей Журавлев «Искусственное повышение резкости 5. High Pass и Overlay». 
Андрей Журавлев «Искусственное повышение резкости 6. Минусы и плюсы метода «High Pass – Overlay». 
2.7. Финальное повышение резкости под различные способы воспроизведения 
Из распространенных технологий наименьшее падение резкости возникает на мониторе. Оно происходит из-
за низкого разрешения экрана. 
Для показа на мониторе резкость повышается просто «на глаз», пока на экране не станет красиво. 
Сильнее резкость падает при выводе на фотобумагу. Основные причины чисто оптические: неаккуратность 
при засветке квадратного элемента изображения круглым пятном лазера и светорассеяние в фотоматериале. 
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Для эффективного управления резкостью необходима печать «пиксел в пиксел», когда изображение не 
масштабируется и каждый пиксел файла экспонируется на фотобумагу как отдельный элемент. 
Как и при просмотре на мониторе резкость оценивают по ощущениям наблюдателя, проще говоря: «на 
глазок». Только теперь интерактивность меньше: придется печатать несколько вариантов и сравнивать их. 
Таким образом придется поступать при любой печати, поэтому при повышении резкости так важен опыт 
корректора в работе с конкретной технологией. 
Сильнее всего резкость падает при офсетной печати. Именно из-за растровых сеток резкость падает сильнее 
всего, поэтому «под офсет» ее повышают больше. И чем ниже линиатура, тем сильнее нужно повышать 
резкость. 
Дополнительные материалы: 
Андрей Журавлев. «Искусственное повышение резкости 8. Повышение резкости под офсетную печать» 
Для самостоятельного изучения: 
Александр Войтехович «Увеличение резкости фотографий». 
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